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1. Introducere
Obiectivul acestui ghid constă în descrierea etapelor și cerințelor necesare pentru realizarea, predarea și susținerea lucrării de licență pentru studenții, care frecventează programele universitare de licență ale Facultății de Arhitectură Navală din cadrul Universității „Dunărea de Jos” din Galați.
Lucrarea de licență reprezintă dovada nivelului și calității pregătirii teoretice, aplicative și profesionale, a absolventului iar, prin modul în care este susținută (oral, în fața unei comisii de examinare) ea pune în valoare cunoștințele, competențele și abilitățile dobândite de absolvent pe parcursul programului de studii. 
Conținutul lucrării de licență trebuie să corespundă specificațiilor din tema lucrării de licență, aprobată în Consiliu Facultății de Arhitectură Navală, fiind recomandată evitarea informațiilor redundante. Este obligatoriu ca formularea să fie clară, concisă și corect scrisă din punct de vedere gramatical.
Scopul elaborării și susținerii unei lucrări de licență este acela de a demonstra că absolventul și-a însușit următoarele cunoștințe, competențe și abilități:
1. Documentarea pe bază de surse bibliografice cât mai diverse din care să poată să extragă informații pertinente și relevante pentru tema aleasă; 
2. Înțelegerea și aplicarea conceptelor fundamentale din domeniul pentru care studentul s-a pregătit; 
3. Realizarea de sinteze din literatura de specialitate și conexă acesteia pentru tematica aleasă;
4. Cunoașterea metodologiilor, metodelor și tehnicilor de proiectare / tehnologie / analiza care să ofere un set de instrumente pentru rezolvarea unor probleme specifice profesiei viitoare;
5. Aplicarea cunoștințelor teoretice pentru un caz concret / o aplicație / un studiu care vizează soluționarea aspectelor practice din domeniul pentru care studentul s-a pregătit. Înțelegerea și definirea unei probleme inginerești, precum și analiza de soluții constructive, creative și inovative pentru situații reale, utilizând o argumentare adecvată;
6. Prelucrarea / analiza rezultatelor obținute în urma calculelor, experimentelor sau simulărilor numerice.
7. Formularea unor opinii privind corelația teoretico-practică, cu referire la disciplinele studiate și aplicarea în studiul de caz a cunoștințelor, abilităților și competențelor obținute;
8. Susținerea unei prezentări prin care să dovedească un limbaj adecvat contextului cerut de tema lucrării, vocabular de specialitate, putere de sintetiză a unui volum mare de informații într-un timp impus (de regulă 15 minute);
9. Dialogarea cu membrii comisiei pe subiecte direct legate de temă sau conexe temei.
Studenții au oportunitatea de a elabora o lucrare de foarte bună calitate, cu elemente de creativitate, care poate fi selecționată pentru premiere de către firme interesate în recrutarea de personal înalt calificat.




2. Structura lucrării de licență
Lucrarea este structurată pe capitole și include următoarele elemente obligatorii:
· Copertă – este prezentată în Anexa 1. Pentru coperta lucrării de licență se va utiliza documentul “Nume Prenume - Specilizarea - Format Lucrare Licență.docx”.
· Pagina de gardă – informațiile care trebuie să apară în pagina de titlu a lucrării sunt prezentate în Anexa 2. Pentru pagina de gardă se va utiliza documentul “Nume Prenume - Specilizarea - Format Lucrare Licență.docx”.
· Cerere de înscriere la examenul de licență (Anexa 3) – semnat de către student și conducător. Cererea semnată se va scana și se va introduce în documentul PDF unic care reprezintă forma electronică a lucrării (se consideră document separat, nu se va include în lucrarea de licență);
· Referat asupra lucrării de licență (Anexa 4) - se consideră document separat, nu se va include în lucrarea de licență;
· Declarație de onestitate academică – lucrarea va conține o declarație pe propria răspundere a absolventului, datată și semnată în original. Conținutul declarației este prezentat în Anexa 5. Declarația semnată se va scana și se va introduce în documentul PDF unic care reprezintă forma electronică a lucrării. Absolvenții trebuie atenționați asupra consecințelor pe care le atrage plagierea, preluarea unor lucrări de la alte generații de absolvenți sau de la alte universități, precum și citarea incorectă a surselor (îndeosebi omiterea citării surselor de proveniență a informațiilor, ceea ce echivalează un furt din proprietatea intelectuală a altui autor). Prezentarea lucrării atât în format printat, cât și electronic, vizează supunerea lucrării la softul de detectare a plagiatului. Absolvenții vor semna o declarație pe proprie răspundere prin care confirmă că lucrarea este rezultatul efortului propriu (Anexa 5). De reținut că aprobarea lucrării de către cadrul didactic nu exclude posibilitatea ca o depistare ulterioară să anuleze examenul de licență sau de disertație, respectiv să ducă la anularea diplomei. Îndrumătorii de lucrare au obligația să informeze studenții că plagierea este furt intelectual și poate avea consecințe penale;
· Cuprins – lucrarea va avea un cuprins care să conțină cel puțin titlurile tuturor capitolelor însoțite de numărul paginii la care începe fiecare capitol;
· Lista figurilor și lista tabelelor – în cazul în care lucrarea conține figuri (imagini, grafice) și/sau tabele numeroase, acestea vor fi prezentate, imediat după cuprins, sub forma unor liste (separat pentru figuri și tabele) care conțin numele fiecărui element și numărul paginii la care se află acesta;
· Lista acronimelor – se vor lista, în ordine alfabetică, toate acronimele folosite în text, împreună cu semnificația inițialelor și traducerea în limba română (dacă este cazul);
· Capitole – lucrarea va conține capitole numerotate crescător; 
· Bibliografie – va conține lista tuturor surselor de informație utilizate de către absolvent pentru redactarea lucrării  și care au fost citate în text;
· Anexe (după caz) – acestea  se numerotează în ordine crescătoare, începând cu Anexa 1. Fiecare anexă se va menționa cel puțin o dată în textul lucrării, ca referință. Anexele nu se includ în calcularea numărului de pagini al lucrării.



3. Recomandări privind conținutul capitolelor lucrării de licență (Promoția 2024)
3.1. Introducere (2-5 pagini) 
Descrierea contextului în care se încadrează tema lucrării.  Prezentarea / stabilirea problemei abordate; Declararea și motivarea scopului temei / obiectivelor lucrării; Formularea problemei abordate și prezentarea pe scurt a lucrării/prezentarea succintă a capitolelor lucrării. 
3.2. Documentare asupra metodelor / regulilor și normelor / echipamentelor / tehnologiilor / software-uri existente (3-7 pag)
Documentarea pentru lucrarea de licență se referă la consultarea literaturii de specialitate cu privire la subiectul abordat în lucrare. Investigarea diferitelor metode / echipamente / tehnologii / software-uri, compararea acestora și identificarea avantajelor și dezavantajelor. Cerințele normelor in vigoare.
3.3. Noțiuni de proiectare / Descrierea proceselor tehnologice / Noțiuni teoretice / Descrierea metodologiilor de analiză (5-10 pag) 
Acest capitol reprezintă o sinteză a conceptelor teoretice legate de tema abordată, utilă pentru fundamentarea metodologiei de cercetare şi a instrumentelor folosite. Pentru elaborarea acestei secțiuni a lucrării de licență, studentul va consulta bibliografia recomandată în timpul anilor de studii precum şi cea indicată de coordonatorul lucrării.
3.4. Aplicații de specialitate (calcule / analize / rezultate) (15-50 pag)
Descrierea condițiilor de proiectare / de realizare a procesului tehnologic / de calcul; Prezentarea rezultatelor sub formă de tabele, grafice, scheme, poze; Analiza rezultatelor și studii comparative.
3.5. Analiza economică a proiectului/tehnologiei/studiului (Opțional) (3-5 pag)
Împărțirea lucrării în activități și planificarea acestora, evaluarea bugetului de ore pe activități / lucrări, evaluarea costului de fabricare, analiza riscului implementării unei anumite soluții.
3.6. Concluzii (1-2 pag)
Scurtă descriere a lucrării; Prezentarea celor mai importante aspecte / realizări ale lucrării de licență; Direcții de continuarea a studiului realizat.
3.7. Bibliografie
Bibliografia poate să cuprindă diferite surse: cărți, articole, adrese de internet, iar pe parcursul textului se vor face trimiteri la notele bibliografice și este obligatorie corelarea acestora cu trimiterile făcute în textul lucrării. 
3.8. Anexe (dacă este cazul)
În anexe se includ scheme ale instalațiilor, planuri, coduri sursă scrise de absolvent, fotografii ale modelelor sau din timpul experimentelor (dacă există), anumite grafice (dacă sunt prea numeroase pentru a fi listate direct în cadrul capitolelor). Pot fi adăugate ca anexe materiale care nu reprezintă contribuția absolventului (de exemplu: cod sursă a unor biblioteci deja existente, descrieri tehnice ale unor echipamente, foi de catalog a unor componente etc) cu menționarea explicită a faptului că aceste materiale nu reprezintă contribuția autorului. Anexele nu se includ în calcularea numărului de pagini al lucrării.


4. Reguli de redactare a lucrării de licență
4.1. Reguli generale de redactare
Tehnoredactarea lucrărilor de licență va respecta următoarele exigenţe:
· Formatul lucrării va fi A4, numărul maxim de pagini (exclusiv anexele) va fi 100;
· Pentru redactare se va folosi un program de tehnoredactare (exemple: Microsoft Word, Open Office);
· Documentul “Nume Prenume - Specializare - Tamplate Format Lucrare Licență.docx” conține formatarea automată în concordanță cu regulile de redactare prezentate în continuare; 
· Limba de redactare va fi obligatoriu limba programului de studiu al absolventului. Prin excepție, lucrările realizate în cadrul unor stagii/burse la facultăți din străinătate efectuate în ultimul semestru universitar, și având ca scop  pregătirea lucrării în străinătate, pot fi redactate în limba străină respectivă, cu aprobarea conducătorului lucrării de licență și a directorului de departament;
· Textul va respecta o spaţiere între rânduri Single, iar fontul utilizat pentru redactarea lucrării va fi Times New Roman, Size 14 pt pentru titlul capitolelor , Size 12 pt pentru titlul subcapitolelor, Size 12 pt pentru textul lucrării;
· Se utilizează diacriticele specifice limbii române (ă, ş, ţ, î, â);
· Înainte de semnele de punctuație nu se lasă spațiu;
· După semnele de punctuație se lasă întotdeauna spațiu;
· După deschiderea și înainte de închiderea unei paranteze (indiferent de tipul ei: rotundă, pătrată) nu se lasă niciodată spațiu;
· Pentru scrierea ecuaţiilor nu se folosesc parantezele de pe tastatură;
· Printarea se va face pe o singură față a paginii format A4;

4.2. Formatul lucrării
Formatul întregii lucrări este A4 (Page Layout → Page Setup → Paper, vezi figura 4.1)
Pentru marginile paginii se vor utiliza următoarele valori (Page Layout → Page Setup → Margins): Top 2.0 cm, Left 2.5 cm, Bottom 2.0 cm, Right 2.0 cm (vezi figura 4.2).
Pentru antet și subsol formatarea se va face astfel (Page Layout → Page Setup → Layout): Header 1.25 cm, Footer 1.25 cm (vezi figura 4.3). În antet se va trece « Universitatea “Dunărea de Jos” din Galați | Facultatea de Arhitectură Navală », iar în subsol numărul paginii, centrat.
Cuprinsul va fi inserat astfel: Refrences → Tabel of Contents → Custom Table of Contents (vezi figura 4.4)
Titlurile capitolelor se vor seta Heading 1, urmând ca subcapitolele să fie setate Heading 2, Heading 3 ... și așa mai departe (vezi figura 4.5)
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	Figura 4.1 Formatarea paginii
	Figura 4.2 Setarea marginilor paginii
	Figura 4.3 Formatare antet si subsol
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	Figura 4.4 Inserare cuprins
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	Figura 4.5 Setare Heading


4.3. Spaţierea între rânduri si alinierea textului
Textul va respecta o spaţiere între rânduri Single (Paragraph → Indents and Spacing → Spacing → Line spacing → Single, vezi figura 4.6). Primul rând al fiecărui paragraf va avea o indentare de 1.25 cm (Paragraph → Indents and Spacing → Indentation → By, vezi figura 4.7), excepţie făcând titlurile capitolelor, care vor fi aliniate centrat (Center), precum şi etichetele tabelelor şi figurilor (a se vedea explicaţiile din tabelul 4.1 de mai jos). Textul din cadrul paragrafelor va fi aliniat stânga-dreapta (Justified). 
Titlurile capitolelor vor respecta o spatiere Before 12 pt, After 12 pt, Single (vezi figura 4.8), iar subcapitolele vor respecta o spatiere Before 6 pt, After 6 pt, Single (vezi figura 4.9).
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	Figura 4.6 Spaţierea între rânduri
	Figura 4.7 Formatarea indentației
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	Figura 4.8 Spaţierea titlurilor capitolelor
	Figura 4.9 Spaţierea subcapitolelor


4.4. Fontul utilizat pentru redactarea lucrării
Fontul utilizat pentru redactarea lucrării va fi Times New Roman, cu parametri prezentaţi în tabelul 4.1, cu observaţia că pentru secvenţe cod se va utiliza Courier New cu parametri prezentaţi în acelaşi tabel.
	Tabelul 4.1 Tehnoredactarea lucrarii

	Nr. crt.
	Stil tehnoredactare
	Parametri

	1
	Titlu antet
	Times New Roman, Size: 10, Centered

	2
	Titlurile capitolelor
	Heading 1: Times New Roman, Size 16, Style Bold, Justify

	3
	Titlurile subcapitolelor
	Heading 2 Times New Roman, Size 13, Style: Bold, Justify

	4
	Titlurile subcapitolelor
	Heading 3 Times New Roman, Size 12, Style: Bold, Justify

	5
	Textul lucrării
	Times New Roman, Size: 12, Style: Regular, Justified, Sentence case

	6
	Text cuprins
	Times New Roman, Size: 12, Style: Regular, Justified

	7
	Text interior tabele
	Times New Roman, Size: 10, Style: Regular, Centered, Sentence case

	8
	Text denumire figuri
	Times New Roman, Size: 12, Style: Regular, Centered, Sentence case

	9
	Text denumire tabele
	Times New Roman, Size: 12, Style: Regular, Right, Sentence case

	10
	Text formule, notaţii cu indici
	Insert equation, Cambria Math, Size:12, Italic, Centered

	11
	Text pentru secvenţe cod
	Courier New: 10 Style: Regular, Justified

	12
	Text resurse bibliografice
	Times New Roman, Size: 12, Style: Regular, Justified, Sentence case

	13
	Inserare număr pagină
	Times New Roman, Size: 12, Style: Bold, Centered


4.5. Tabelele
Tabelele se numerotează cu două numere (cifre arabe), primul reprezentând numărul capitolului, iar cel de al doilea, reprezentând numărul tabelului (în ordinea apariției în text) din capitolul respectiv. Titlu tabelului se menţionează într-o linie de tabel înaintea capului de tabel (vezi tabelul 4.2). Marginile punctate ale liniei ce conține denumirea tabelului vor fi setate No Border (vezi figura 4.10). Fontul utilizat este Times New Roman, Size 12, Style Bold, pentru numărul tabelului, Regular pentru titlul acestuia, Align Center, iar pentru conținutul tabelului Times New Roman, Size 10, Align Center Înainte și după fiecare table se va utiliza o spațiere de 6 pt, Single (vezi figura 4.11), iar în interiorul tabelului se va utiliza o spațiere de 2 pt, Single (vezi figura 4.12). În cazul în care tabelul este preluat, sursa acestuia se indică imediat după denumire printr-un număr între paranteze pătrate ce va corespunde numărului referinței bibliografice de unde a fost extras respectivul tabel. Se recomandă alinierea centrală a tabelelor, Center, dacă acestea nu acoperă toată lăţimea paginii. Fiecare tabel trebuie menționat în text şi va fi inserat cât mai aproape de prima referinţă.
	Tabelul 4.2 Exemplu de tabel

	
	
	
	
	
	
	
	

	0.2
	3.76
	1.13E+08
	2.05E-03
	10.9
	4.08E-03
	3.06
	0.07

	0.3
	5.64
	1.70E+08
	1.93E-03
	30.0
	5.02E-03
	3.01
	0.12

	0.4
	7.52
	2.26E+08
	1.86E-03
	70.3
	6.61E-03
	2.92
	0.30

	0.5
	9.40
	2.83E+08
	1.80E-03
	145.5
	8.75E-03
	2.89
	-2.03

	0.6
	11.28
	3.40E+08
	1.76E-03
	150.5
	6.28E-03
	2.96
	-2.02

	0.7
	13.15
	3.96E+08
	1.72E-03
	158.3
	4.86E-03
	3.04
	-1.63

	0.8
	15.03
	4.53E+08
	1.69E-03
	170.8
	4.01E-03
	3.09
	-1.23
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	Figura 4.10 Fără chenar
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	Figura 4.11 Spaţierea între rânduri înainte și după fiecare tabel
	Figura 4.12 Spaţierea în interiorul tabelului


4.6. Figurile
Figurile și denumirile lor se inserează înntr-un tabel al cărui margini vor fi setate No Border (vezi figura 4.14). Figurile se numerotează cu două numere (cifre arabe), primul reprezentând numărul capitolului, iar cel de al doilea, fiind numărul figurii (în ordinea apariției în text) din capitolul respective. Titlu figurii se mentionează sub aceasta într-o linie de tabel (diferită de cea în care este inserată figura). Fontul utilizat este Times New Roman, Size 12, Style Bold, pentru numărul figurii, Regular pentru titlul acesteia, Align Center. Înainte și după fiecare tabel ce conține o figură se va utiliza o spațiere de 6 pt, Single (vezi figura 4.15), iar în interiorul fiecărui tabelului ce conține o figură se va utiliza o spațiere de 2 pt, Single (vezi figura 4.16). În cazul în care tabelul este preluat, sursa acestuia se indică imediat după denumire printr-un număr între paranteze pătrate ce va corespunde numărului referinței bibliografice de unde a fost extras respectivul tabel. Se recomandă alinierea centrală a tabelelor ce conțin figuri, Center, dacă acestea nu acoperă toată lăţimea paginii. Fiecare figură trebuie menționat în text şi va fi inserată cât mai aproape de prima referinţă.
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	Figura 4.13 Exemplu de figura cu referinta [*] ( unde * reprezintă numărul corespunzător referinței bibliografice)
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	Figura 4.14 Fără chenar
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	Figura 4.15 Spaţierea între rânduri înainte și după fiecare tabel ce conține o figură
	Figura 4.16 Spaţierea în interiorul tabelului ce conține o figură


Graficele vor respecta aceleași indicații ca și în cazul figurilor. Graficele vor purta titluri adecvate și vor avea o etichetă pe fiecare axă, descriind semnificaţia acesteia, menţionând unitatea de măsură acolo unde este cazul (vezi figurile 4.17 și 4.18).
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	Figura 4.17 Exemplu de grafic unde sunt exemplificate curbele rezistentei totale pentru diferite cazuri de calcul
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	Figura 4.18 Exemplu de grafic unde sunt exemplificate curbele coeficientului rezistentei totale pentru diferite cazuri de calcul


4.7. Ecuaţii, simboluri și notații cu indici
Pentru introducerea în text a formulelor de orice formă, a simbolurilor si a notaţiilor cu indici de orice fel se recomandă folosirea editorului de ecuaţii (Insert → Equation → Insert New Equation). Ecuaţiile se vor insera intr-un table ca în exemplul de mai jos, unde limitele punctate ale tabelului vor fi setate No Border (figura 4.19). Înainte și după fiecare tabel ce conține o formula matematică se va utiliza o spațiere de 6 pt, Single (vezi figura 4.20), iar în interiorul fiecărui tabelului ce conține o formula matematică se va utiliza o spațiere de 2 pt, Single (vezi figura 4.21).Ecuaţiile se scriu cu aceeaşi înălţime de font ca şi corpul textului şi se etichetează între paranteze rotunde cu două numere (cifre arabe), primul reprezentând numărul capitolului, iar cel de al doilea, fiind numărul ecuaţiei din capitolul respectiv. Alinierea se va face astfel: tabelul Center, pentru formule Left Center, iar pentru numerotare Right Center.
	
	(4.1)
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	Figura 4.19 Fără chenar
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	Figura 4.20 Spaţierea între rânduri înainte și după fiecare tabel ce conține o ecuație
	Figura 4.21 Spaţierea în interiorul tabelului ce conține o ecuație


Ca și în cazul formulelor, simbolurile și a notaţiile cu indici de orice fel se vor insera cu ajutorul editorului de ecuaţii (Insert → Equation → Insert New Equation). 
În cazul apariției a simbolurilor și a notaţiilor cu indici în text se va proceda ca în exemplul urmator: 
Pentru fiecare raport  studiat s-a reazlizat un table centralizator în care sunt trecute: valorile vitezei () și numărului Froude () corespunzător, valorile numărului Reynolds () și ale coeficientului de frecare (), valorile rezistenței de val () și ale coeficientului rezistenței de val (), valorile rezistenței vâscoase () și ale coeficientrului rezistenței vâscoase (), valorile rezistenței totale () și ale coeficientului rezistenței totale (), valorile afundării () și ale asietei dinamice ().
iar în cazul apariției acestora în cazul unui table se va proceda ca în cazul tabelului 4.3: 
	Tabelul 4.3 Exemplu de simboluri si notatii cu indici in cazul unui tabel

	Caracteristicile principale
	Simbol
	Valoare
	Unitate de masura

	Lungimea maximă
	
	37.429
	

	Lungimea la plutire
	
	35.786
	

	Lungimea între perpendiculare
	
	36.000
	

	Lățimea maximă
	
	12.000
	

	Pescajul
	
	2.498
	

	Înălțimea de construcție
	
	4.926
	


4.8. Codul sursă
Codul sursă al programului (proiectului) poate fi introdus în totalitate în lucrare într-o anexă, cu recomandarea ca liniile de cod să fie comentate în mod extensiv sau introducerea părţilor esenţiale de cod în cadrul materialului lucrării, sub formă de secvenţe de cod care exemplifică/ilustrează/de-monstrează modul de abordare şi implementare al diverşilor algoritmi, tehnici şi structuri de date utilizate în proiect.
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	Figura 4.22 Exemplu de cod, împreună cu captura aferentă


4.9. Bibliografia
Referințele bibliografice se vor scrie la sfârșitul lucrării. Numerotarea acestora se va face cu cifre arabe, începând cu cifra 1 și vor fi listate în ordinea apariției în text. Numărul fiecărei referințe va fi trecut în paranteze pătrate. Acestea se tehnoredactează cu Font Times New Roman, Size: 12, Style: Regular, Justified, Sentence case.
Referințele bibliografice se vor scrie dupa exemplul următor:
· Pentru articole:
[1]	Abbott, M. B., Petersen, M. M.,  Skovgaard, O., On the numerical modelling of short waves in shallow water, Jnl. Hydraulic Res.; Vol. 16 (3), 1978, pp. 23-44.
SAU
[2]	Vigner, G., Lire: comprendre ou décoder?, Le français dans le monde, 283, 1996, pp. 62-69.
· Pentru cărţi:
[3]	Grady, C.P.L., Lim, H., Biological Wastewater Treatment Theory and Application, Marcel Dekker, New York, 1980, pp. 375-390.
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